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INTRODUCCIÓN

La aplicación Macromedia Flash representa un programa de autoría muy poderoso dirigido a desarrollar diseños vectoriales dinámicos y livianos para la Internet/Web, discos compactos (CD) multimedios-interactivos, animaciones vectoriales, entre otros.  Desde su concepción, este programa se caracteriza por la producción de conceptos digitales de naturaleza vectorial, es decir, instrucciones matemáticas para construir líneas y curvas, las cuales mantienen siempre su resolución original, sin importar cuan grande sean (escalabilidad); ejemplo:  la animación de contenido gráfico elaborado con vectores que permiten un control de su visualización en los sitios Web.  Además, por su esencia vectorial, los archivos son relativamente más pequeños que aquellos creados con imágenes en mapa de bits o” bitmaps”.  Consecuentemente, los productos para el Web no requieren una conexión rápida.

Macromedia Flash es actualmente el líder en lo que respecta a la creación de animaciones para la Web y cada día gana más auge.  Este programa representa una prodigiosa aplicación que permite crear páginas Web profesionales de alto contenido interactivo.  Efectivamente, a raíz de la demostrada potencia y versatilidad de este programa, es posible añadir a una página Web desde un sencillo botón hasta la más compleja de las animaciones; incluso se podrá diseñar un sitio Web completo desde Flash.

Para poder lograr eso, Flash proporciona una gran variedad de herramientas con las que se logrará instaurar películas a base de animaciones, botones estáticos o animados, sonidos y música.  Además, las películas podrán ser interactivas para que respondan a determinados eventos y poder tener control sobre las secuencias de animación, añadir acciones, interactividad y otros recursos.

La creación de una película en Flash comprende desarrolar un dibujo o la importación de una ilustración, la organización en el Escenario (Stage) y su animación con la Línea de Tiempo (Linetime).  La película puede hacerse interactiva utilizando acciones que provoque a la animación responder particularmente a determinados eventos.
Una vez terminada la película, es posible exportarla para verla en Flash Player o bien como un proyector de Flash independiente, lo cual permite observarse con un reproductor que se incluye con la película misma.

Las películas de  Macromedia Flash MX pueden reproducirse de varias formas:

· En navegadores Internet, tales como Netscape Navigator y Microsoft Internet Explorer, que estén equipados con Flash Player.

· Con el control ActiveX de Flash en Microsoft Office, Microsoft Internet Explorer para Windows y otros entornos anfitrión de ActiveX.

· En Flash Player, una aplicación independiente de manejo similar al complemento Flash Player.

· Como un proyector independiente, un archivo de película que se puede reproducir sin disponer de Flash Player.

Las Alternativas o Comandos encontradas en los Menús de Flash: Abreviaturas, Frases y Funciones de Tecla do Empleadas en este Trabajo

En este escrito se habrán de emplear ciertas abreviaciones y frases particulares que se refieren a los comandos y procedimientos básicos del programa de Macromedia Flash, es decir, los diferentes niveles de las alternativas o comandos que se encuentran en los menús.  Para simplificar los pasos de una tutoría o función ha ser ilustrada, se incorporarán flechas (→) para indicar un cambio o secuencia en el comando o procedimiento a seguir (las alternativas o comandos presentes en el menú).  Por ejemplo, al explicar cómo acceder una vista o examen previo (previsualización) de un proyecto creado en Flash MX diseñado para el Web, se indicará que se debe ir a la Barra de Menú y seleccionar "File" (Archivo), luego se observará un menú vertical, del cual se escoge: "Publish Preview" (Previsualizar lo Publicado) seguido de "Flash".  Estos pasos se puede simplificar de la siguiente manera (alternativas a seguir del menú): File→Publish Preview→Flash (Archivo→Previsualizar lo Publicado→Flash.  En otro ejemplo, la expresión Modify→Transform→Scale (Modificar→Transformar→Escalar) significa que hay que abrir el menú Modify (Modificar) elegir la alternativa Transform (Transformar) y en el siguiente menú que se abrirá escoger la alternativa Scale (Escalar).

Además, se enfatizará el uso de funciones o atrechos de teclado con el fin de agilizar el proceso de crear un trabajo en Flash.  Utilizando el ejemplo anterior, para los usuarios de Microsoft Windows, el desarrollador o diseñador de Flash MX puede presionar las teclas de [Ctrl] + [F12] para ver el examen previo de un proyecto a ser publicado en el formato de HTML ("HyperText Markup Language" o Lenguaje de Etiquetación de Hipertexto).  En el caso de la plataforma Macintosh, el equivalente de esta función en el teclado es: [Cmd] + [F12].
Beneficios y Utilidades de Macromedia Flash
En comparación con otros programas, los archivos de Flash son relativamente pequeños, de manera que son rápidos de bajar.  También, Flash permite al desarrollador mayor control visual de su diseño, comparado con las limitaciones que posee la autoría de HTML.  Además, este programa provee herramientas poderosas para la creación de multimedios interactivos.  Flash permite combinar imágenes en formato vectorial y mapas de bits ("bitmaps") e incorporar video y sonido.  Los archivos de Flash mantienen siempre su escala y posición original.  Finalmente,  los archivos de Flash bajan al Web en pequeñas unidades, esto permite que parte del contenido se muestre, mientras que el resto este bajando en el fondo, lo cual se conoce como descarga  progresiva (progresive download)
En resumen, las ventajas y usos de Macromedia Flash incluyen las siguientes:  (1) establecimiento de atractivas interfaces, y aplicaciones complejas, livianas para el Web, que no requieren un ancho de banda amplio (2) animaciones vectoriales de trabajos artísticos (3) integración de elementos multimedios en aplicaciones interactivas; ejemplo:  audio, video, animación, gráficas y texto (4) versatilidad para que los proyectos se publiquen para la Internet/Web, dispositivos móviles (Ej: celulares) o sean distribuidos mediante un CD-ROM/DVD (5) incorporación de un lenguaje de programación orientado a objetos, conocido como ActionScript, el cual es compatible con las especificaciones de ECMA-262 (6) intregración de otros lenguajes para el desarrollo de páginas WWW, entre las que se pueden nombrar:  Lenguaje de Etiquetación de Hipertexto Extensible (XHTML, siglas en Inglés), JavaScript y otros (7) interactividad, a través de botones, hipertextos y la ayuda de codificación (ActionScript) (8) permite bajar progresivamente el contenido de un sitio Web; llamado descarga  progresiva (progresive download)  (9) capacidad para importar una variedad de elementos multimedios en distintos formatos, a saber:  videos (mpg, avi, wmv, QuickTime, dvi, flv), imágenes/gráficas (wmf, emf, eps, ai, dxf, bmp, jpg, gif, png, pdf) y sonido (mp3, wav y formato AIFF para plataformas Mac OS).

El Concepto de Animación
Por años, Macromedia Flash ha sido reconocida como una poderosa herramienta para generar animaciones confeccionadas con imágenes vectoriales.  El principio es similar a las películas que vemos en el cine.  Se trata de un conjunto de imágenes, cada una circunscrita a un marco (fotograma) y levemente diferentes entre sí, que cuando se presentan a una frecuencia de tiempo específica, y se sincronizan con sonido, crean la ilusión del movimiento.  Consecuentemente, una animación consiste de un conjunto de dibujos estáticos, diferentes entre sí, que se presentan de manera incremental a través de diferentes etapas de un movimiento.
En Macromedia Flash, tal simulación del movimiento se le da el nombre de película, esto es, un archivo de Flash creado en el ambiente de autoría.  Los fragmentos de película (movie clips) representan breves segmentos de las animaciones creados en este programa de autoría.  Las películas generadas en Flash pueden ser visualizadas mediante el Reproductor de Flash (Flash Player).  Entonces, este reproductor es un sistema que permite ver las películas/animaciones de Flash en una computadora o en los Visualizadores del Web (Web Browsers).  El reproductor más reciente (ver 8.0) se puede bajar del sitio Web de Macromedia (www.macromedia.com).
El programa de Flash permite al usuario crear imágenes estáticas, cada una de las cuales representa un fotograma.  En realidad, un fotograma representa una mínima cantidad de tiempo (½), que al desplazarse una detrás de la otra crean la animación.  Cuando las gráficas generadas son significativamente diferentes unas a otras, se le denominan como fotogramas claves, es decir, los fotogramas más cruciales que definen el movimiento.  Los fotogramas claves son, pues, cualquier alteración marcada en el contenido o imagen del fotograma original.  Aquel grupo de fotogramas que se hallan entre dos fotograma claves se conocen como fotogramas entre medio.  Éstos, manifiestan cambios progresivos de los elementos de una imagen, lo cual simula el movimiento continuo.  Las posibles animaciones o películas de Flash pueden ser desarrolladas de diferentes maneras, estas son:  fotograma a fotograma (frame-by-frame), movimientos interpolados (motion tweening) y forrmas interpoladas (shape tweening).  Tales tipos de animaciones serán discutidas más adelante. 

Los Formatos de Archivo de Flash
Las animaciones generadas por Macromedia Flash pueden publicarse en varios formatos, es decir, esta aplicación permite desarrollar seis tipos de archivos particulares, entre los cuales se pueden mencionar:  (1) formato nativo o de autoría o "project files" (archivos de proyectos) (.fla) (2) formato de reproductor de Flash o "movie files" (archivos de película) (.swf) (3) proyector de Windows, autoejecutable o "projector files" (archivos de proyectores) (.exe) (4) proyector de Macintosh (.hqx) (5) animaciones GIF (.gif) y (6) videos Quicktime (.mov).

Los Tres Tipos de Archivos de Mayor Usos Creados en Macromedia Flash

Los principales archivos desarrollados por Flash se describen a continuación:

"Project File" (Archivo del Proyecto): .fla:  Este tipo de archivo representa aquel empleado para desarrollar el contenido de un trabajo en Flash MX, incluyendo animaciones, interactividad, entre otros posibles atributos del proyecto.  Como fue mencionado previamente, este archivo es el que puede ser editado para mejorar el trabajo y se almacena en el formato de .fla.  Esta extensión se deriva de las primeras tres letras del programa Flash MX (Flash).

"Movie File" (Archivo del Película): .swf:  Este es el formato de archivo que se incorpora en las páginas HTML del Web.  Comúnmente esto archivos no pueden ser editados.  El formato .swf representa el acrónimo de: "Small Web Page" (Pequeña Página Web).

"Movie Projector File" (Archivo del Proyector de la Película): .exe (Windows), .hqx (Macintosh):  Representa un pequeño programa ejecutable preparado para correr en cualquier computadora, sin la necesidad de tener instalado la aplicación de Macromedia Flash MX ni su proyector.  Este es, pues, un archivo independiente (autoejecutable) compilado desde Macromedia Flash.

En resumen tenemos que los tipos de archivos en Flash son:

· Archivos Editables - con la extensión  .fla:  Tipo de archivo que nos permitirá ver cómo está hecha la película y modificarla en su totalidad..   Es el archivo que contiene el desarrollo de la película sin compilar.

· Archivos Publicados - con la extensión  .swf:  Tipo de archivo que corresponde a la película ya publicada y solo permite su visualización pero no su edición.  Es el archivo que contiene la película compilada y que utilizaremos para su publicación en la Internet/Web.  Para poder visualizar este archivo se necesita la utilidad de un “flash player” (reproductor de flash), el cual está disponible en su computadora cuando lo baje desde el sitio Web de macromedia.  Los navegadores actuales ya poseen este reproductor.

· Archivos Autoejecutables – con la extensión  .exe:  Archivo que incorpora el reproductor necesario para ver una película flash.

· Archivo Web – con la extensión  .html:  Es el que contiene el código HTML necesario para poder ver directamente la película en el navegador.

Tipos de Aplicaciones en Macromedia Flash

Para evitar la confusión con el uso de términos, en esta sección se describirán varios conceptos muy similares e interrelacionado concerniente con el propósito específico de los archivos de Macromedia Flash.
"Macromedia Flash Authoring Tool" (Macromedia Flash como herramienta de Autoría).  Representa la aplicación o programa diseñado para desarrollar el contenido de los archivos de Flash.  Permite crear y editar trabajo de arte, la producción de animaciones, incorporación de video y audio y desarrollar interactividad.  Los proyectos creados con la herramienta de autoría de Macromedia Flash se guardan empleando la extensión de .fla.  Este formato solo es el de autoría y no puede ser utilizado para publicarlo en el Web, es decir, representa el formato de archivo empleado únicamente para editar y crear el contenido del proyecto.  Mediante el archivo .fla se puede exportar a un formato publicable para los documentos HTML, el cual se rotula con la extensión .swf.

"Macromedia Flash Player" (Ejecutor de los Archivos Flash).  Representa un ejecutable que permite ver los archivos ,swf publicados en las páginas HTML del Web.  Este ejecutable de los archivos .swf comunmente se encuentra instalado en los Navegadores Visuales del Web.  Existe también la alternativa de bajarlo gratuitamente desde el sitio de Web de Macromedia  (http://www.macromedia.com/software/downloads).

"Macromedia Flash Projector" (Proyector de Macromedia Flash).  Estos son archivos autoejecutables (.exe para Windows y .hqx en Macintosh) creados en la aplicación de Flash MX.  Se emplean para distribuirse en CD interactivos,  en unidades de discos flexibles o vía correo electrónico.  Por lo regular, estos archivos no se distribuyen a través del Web.

Vectores Versus Bitmaps

Los bitmaps son gráficos de gran tamaño constituidos a base de píxeles (puntos de imagen) que forman parte de un conjunto que obliga a seleccionarlo todo a la vez, ya que en principio, lo que aparece en la imagen no son elementos individuales sino un “todo” inseparable.  Cada imagen consta de un número determinado de píxeles que determinan su resolución, la cual es fija y no varía con el tamaño, cosa que provocará distorsiones si se reduce, o la aparición de un aspecto dentado si se amplía.


En cambio, un dibujo vectorial es un archivo de tamaño reducido que consta de líneas, curvas y otros objetos independientes que se pueden seleccionar y editar por separado.  Además, la calidad de los gráficos vectoriales no se ve afectada por el tamaño, lo cual permite reducirlos o agrandarlos sin que aparezcan distorsiones.


De lo dicho se extrae que los archivos que genera Flash serán pequeños para lo que contienen, lo cual provocará que su carga sea razonablemente rápida.  Además, al tratarse de vectores, podremos variar su tamaño en la página sin que su calidad varíe ni un ápice.  De este modo, nos podemos encontrar con la paradoja de que en una página Web tarde más en cargarse un gráfico bitmap de tamaño medio que toda una espectacular presentación Flash a página completa animada, con sonidos, efectos, entre otros
Recomendaciones en cuanto a las Capas
Para una efectiva animación, es necesario seguir un método consistente con respecto a la organización de las capas en la línea de tiempo.  Para éste propósito, se sugiere  el siguiente orden:

Primera capa:  Dedicada a los códigos de Action Scrips.

Segunda capa:  Reservada para los rótulos (labels).

Tercera capa:  Para incluir los comentarios.

Cuarta etapa:  Colocar el sonido.

Quita etapa:  Dedicada para el contenido
Herramientas y Funciones Nuevas y Mejoradas en Flash MX 

Esta nueva versión de Flash incluye mejoras en una diversidad de sus funciones y en la interfaz, lo cual facilita al desarrollador crear con mayor facilidad sus proyectos en Flash.  Al subir el programa, aparece una ventana de bienvenida, la cual le ofrece tres opciones:  "Designer" (Diseñador), "General" (General) y "Developer" (Desarrollador).  Dependiendo de la alternativa seleccionada, aparecerá una ventana configurada particularmente para esta selección.  Si se desea, puede cerrar esta ventana al aplicar un clic con el ratón sobre el encasillado ubicado en la esquina superior derecha rotulado con una "X".  Además, es posible regresar a la ventana de bienvenida al seleccionar Help y luego Welcome (Help/Welcome).  A continuación se describen estas mejoras en el programa:
"Break Apart Text" (Texto Descompuesto)

Crea un bloque de texto separado para cada carácter, de manera que se pueda trabajar con cada letra más fácilmente.

"Code Hinting" (Recomendaciones de Códigos)

Esta nueva herramienta acelera el proceso para escribir el lenguaje de ActionScript al detectar el comando que se esta escribiendo y al ilustrar sugerencias, las cuales muestran la sintaxis correcta del comando.

"Color Mixer" (Mezclador de Colores)

Simplifica el proceso para trabajar con colores y gradientes. 

"Components" (Componentes)

Ofrece elementos de arrastrar-y-soltar (drag-and-drop), tales como cajas, pulsadores o botones de contacto (push buttons), barras de despliegue (scroll bars), entre otros. 

"Distribute to Layers" (Distribuir para las Capas)

Te permite seleccionar múltiples objetos de la capa ("layer") (tal como un texto descompuesto) para luego instantáneamente distribuir cada objeto hacia su capa correspondiente.

"Edit in Place" (Editar en Sitio)

Permite modificar símbolos en sitio, dentro del contexto de sus películas (movies).

"Library: Drag and Drop" (Biblioteca: Arrastrar y Soltar)

Simplifica la habilidad para mover símbolos entre los archivos de Macromedia Flash MX al permitir arrastrar y soltar renglones ("items") desde un lugar al próximo.

"Library: Conflict Resolution" (Biblioteca: Resolución de Conflicto)

Permite al desarrollador o diseñador la resolución de conflictos cuando se añade un renglón de la biblioteca a un archivo de Macromedia MX que ya posee un renglón con el mismo nombre.

"Named Anchors" (Anclas Rotuladas)

Permite a los usuarios que están observado las películas de Macromedia Flash MX emplear los botones de "Forward" (Seguir) y "Back" (Regresar) localizados en los Navegadores Visuales del Web.  Esto es posible debido a la nueva herramienta de anclas rotuladas que permite al usuario navegar de una escena a otra en una segmento de película (movie clip) o desde un punto de ancla rotulado a otro de la película Flash.

"Property Inspector" (Inspector de Propiedad)

Permite el acceso inmediato de los atributos más comunes de la película Flash mediante el empleo de un panel que posee configuraciones modificables para reflejar lo que se encuentra seleccionado en el archivo del proyecto.  El desarrollador o diseñador puede realizar cambios dentro del Inspector de Propiedad.

"Save as Flash 5" (Guardar como Flash 5)

Permite guardar el archivo creado en Flash MX en el formato de Flash 5.

"Sound Controls" (Controles de Audio)

Permite una mejor habilidad para sincronizar eventos de películas con el inicio o final de un archivo de audio.

"Templates" (Plantillas)

Permite emplear o crear una plantilla.

"Timeline" (Línea de Tiempo)

Macromedia Flash MX ha mejorado esta función.  Por ejemplo, ahora incluye la habilidad para organizar las capas empleando carpetas y mayor versatilidad al trabajar con múltiples fotogramas o marcos (frames).

"Vertical Text" (Texto Vertical)

Permite crear un bloque de texto vertical. 

"Video" (Video)

Permite importar video y exportarlo desde una película de Flash MX.

Comenzando Flash
Cuando por primera vez se sube el programa de Flash, se podrá observar la Página de Inicio (Start Page) de Macromedia Flash.  Desde esta ventana se puede seleccionar una de las siguiente alternativas:

1.
Abrir un documento previamente o recientemente preparado.
2.
Crear un nuevo documento de Flash.
3.
Crear documentos nuevos de plantillas (templates).
4.
Enlaces para visualizar/navegar en el sitio de “Macromedia Flash Exchange”, desde donde se pueden bajar extensiones de terceros.
5.
Enlaces para tutoriales de Flash y otros recursos de entrenamiento.
Al abrir un documento e Flash, se entra en el ambiente de autoría de ste programa:

Para Crear un Documento Nuevo
Desde la Página de Inicio (Stara Page), diríjase a la sección rotulada como:  “Create New” y haga un clic sobre el hipertexto:  “Flash Document”.  En resumen, un nuevo documento de Flash puede ser creado como sigue:
Start Page→Create New→Flash Document, o
File→New, o
Ctrl + N
Al iniciar Flash un nueve documento, automáticamente se crea un fotograma clave en blanco en el primer fotograma.
El Misterio de los Fotogramas
Cada vez que alteramos el contenido del escenario o línea de tiempo, creamos cambios en el fotograma.  A continuación el significado de estos cambios:

	Cambio en el Fotograma
	Significado

	[image: image1.bmp]
	Fotograma clave en blanco:  No contiene contenido en ele scenario. Se identifica con un círculo pequeño en blanco(hueco)

	[image: image2.bmp]
	Fotograma clave:  Posee contenido.  Se identifica con un círculo enegresido

	[image: image3.bmp]
	Fotograma clave que posee el contenido de un botón

	[image: image4.bmp]
	Fotograma clave que posee un código de ActionScript

	[image: image5.bmp]
	Último fotograma entre medio de dos fotogramas claves.  Posee un rectángulo hueco.


LA INTERFAZ: EL ENTORNO DE TRABAJO

La Ventana del Documento


Cuando subas el programa de Macromedia Flash MX, podrás observar la Ventana del Documento.  Dicha ventana contiene seis principales elementos, a saber: la Línea de Tiempo (Timeline), el Escenario (Stage), el Área de Trabajo (Work Área), la Barra de Información (Information Bar), las Barras de Herramientas (Toolbox) y los Paneles (Panels) (Véase Figura 1-1).

	[image: image6.wmf]

	

	Figura 1-1: La Ventana del Documento.  Representa el entorno principal de macromedia Flash MX,.  Esta ventana se encuentra constituida por la Línea de Tiempo, el Escenario, el Área de Trabajo, la Barra de Información, las Barra de Herramientas y los Paneles.


La Línea de Tiempo


La línea de tiempo es el lugar donde se refleja lo que va a ir sucediendo a lo largo de la duración de la película.  Se basa prácticamente en la misma filosofía de las películas de cine, es decir, una serie de fotogramas (frames) sucesivos, donde cada uno de los cuales contienen las imágenes que deben aparecer cuando se proyecte la película.  La diferencia más sustancial consiste en que, en el caso de Flash, podemos colocar películas en capas (layers) diferentes de tal modo que al activar la reproducción se proyectarán las películas de todas las capas a la vez, lo cual sería comparable a proyectar en la misma pantalla de un cine varias películas simultáneamente. Cuando se arranque la reproducción de una escena de Flash, se pondrá en marcha la línea de tiempo a la velocidad que le asignemos e irá apareciendo en la pantalla todo aquello que contengan los fotogramas según vaya avanzando el cursor de tiempo (playhead).  Cuando se llegue al último fotograma, o a cualquier otro que deseemos, podremos decidir si debe detenerse todo, comenzar de nuevo la reproducción, saltar a un determinado fotograma, abrir otra escena, entre otros.

Por otra parte, los símbolos de clip de película, es decir, aquellas animaciones que hayan sido definidas como símbolos dispondrán de su propia línea de tiempo, la cual podremos ver de forma individual cuando estemos editando ese clip.

Presionado el icono ( ) que se encuentra en el vértice superior derecho de la línea de tiempo, accederá a un menú que le permitirá configurar el modo de visualización de la línea de tiempo.
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	Figura 1-2: La Línea de Tiempo.  Organiza y controla el contenido del documento en capas y fotogramas a lo largo de un periodo de tiempo.
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	Figura 1-2: La Línea de Tiempo.  Controla y exhibe todos los elementos estáticos y en movimiento del proyecto a través del transcurso de un periodo de tiempo, empleando fotogramas y capas.


	Tabla 1-1: Componentes de la Línea de Tiempo

	COMPONNETE
	DESCRIPCIÓN

	Capas
	Se presentan en una columna localizada en la parte izquierda de la Línea de Tiempo.

	Fotogramas 
	Los fotogramas contenidos en cada capa se presentan en una fila

	Cursor de Tiempo
	Indica cuál fotograma de la Línea de Tiempo se encuentra actualmente mostrada en el Escenario.  Una vez se tiene el trabajo de arte en el Escenario y se han creado diferentes fotogramas, se puede aplicar un clic y arrastrar este Curso de Tiempo para moverlo hacia un fotograma específico.



	Barra de Estado
	· 

	Controles de las Capas
	· 

	Visualizador de los Fotogramas
	· 

	Encabezado de la Línea de Tiempo
	· 

	
	· 

	
	· 

	
	· 

	
	· 

	
	· 

	
	· 

	
	· 

	
	· 

	



Moviendo el Cursor de la Línea de Tiempo


El cursor de la Línea de tiempo se mueve a lo largo para indicar el fotograma actual ilustrada.  El encabezado de la Línea de Tiempo muestra los números de los fotogramas de la animación.  Para poder exhibir un fotograma en el Escenario, se deberá mover el cursor de la línea de tiempo al fotograma deseado
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	Figura 1-2: Cursor de la Línea de Tiempo.  Al moverse.



Fotogramas y Fotogramas Claves

Un fotograma clave es aquel en el cual se haya definido un cambio en la animación o incluido acciones para el fotograma para modificar un documento

El Escenario


El escenario es área rectangular que representa el lugar en donde se va a crear la película y en donde colocaremos las animaciones, clips de película, botones, gráficos y demás elementos que compondrán la escena que estemos creando.


Cada vez que se arranque el programa o se cree un nuevo documento, ese escenario se corresponderá con la escena principal, que es la que contendrá la película final de Flash que utilizaremos, por ejemplo en la Web.


Sin embargo, veremos más adelante cómo ese espacio en blanco que ahora se corresponde con la escena, podrá ser utilizado también como espacio de trabajo independientemente para cerrar y editar de forma individual esos elementos.


En ocasiones, por necesidades de organización y complejidad de una película, podremos definir varias escenas diferentes para una misma película.  El paso de una a otra se realizará mediante acciones que definiremos en el lugar y momento oportuno dentro de cada escena.

El Área de Trabajo


Es el área gris que se encuentra alrededor del escenario.  Esta es el área que no será visible al usuario.  En esta área se pueden colocar objetos para luego ser animados.

Barra de Información

Esta barra muestra la su ubicación actual dentro del archivo del proyecto, es decir, el nombre del escenario actual, un número de botones que dejas para editar las escenas y símbolos y la caja de Zoom.

Caja de Herramientas


Representa una barra larga vertical que contiene las herramientas que son necesarias para crear y editar trabajos artísticos.  Esta caja de da acceso a todas las herramientas que necesitas para crear y modificar los objetos en los proyectos de Macromedia Flash MX

Paneles


Son ventanas que contienen herramientas e información para ayudar más efectivamente el archivo del proyecto.  Cada uno de los paneles puede ser usado para visualizar y modificar elementos dentro del archivo de proyecto.  Por ejemplo, el panel del Inspector de la Propiedad cambia, dependiendo de lo que esté seleccionado y permite hacer cambios rápidos a la selección actual, justamente dentro del panel. 

Objetos de Flash: Símbolos


Los tres principales elementos con los que trabaja Flash son: gráficos, botones y clips de película.  Cada uno de estos objetos de Flash posee una identidad y características propias.


Si se crea un círculo y lo define como símbolo gráfico, ese círculo pasará directamente a formar parte el Library (biblioteca)y lo podrá reutilizar todas las veces que desee, es decir, podrá arrastrarlo desde la biblioteca a la escena las veces necesarias hasta completar el total de círculos que necesite.  No obstante, y esto es lo importante, el archivo final sólo contendrá la información correspondiente a un solo círculo y la posición de todos, con lo cual el tamaño será siempre muco menor.  Esto sucede porque cuando se lleva un símbolo gráfico a la escena, lo que realmente se coloca en ella no es el objeto en sí, sino una representación visual de ese objeto a la cual se le da nombre de Instance (Instancia).  De ese modo, por muchas veces que tenga ese objeto repetido en la escena, el espacio del archivo se mantendrá pequeño porque sólo contendrá la información del objeto original y las coordenadas de sus repeticiones en la escena.  Además, si se modifica el objeto original, todas sus reproducciones cambiarán automáticamente, con lo que puede verse que es mucho más práctico definir todos los gráficos como símbolos en ligar de dibujarlos directamente en la escena.


Por otra parte, los botones ya son símbolos desde el momento en que se crean.  Como veremos más tarde, para crear botones hay que hacerlo en una ventana de trabajo especial que aparecen los elementos necesarios para asignar al botón sus propiedades cuando se encuentre en reposo, señalando por el cursor o pulsado por éste.


En cuanto a los clips de película, aunque éstos también pueden crearse directamente en la ventana de la escena, si se definen como símbolos gozarán de las mismas ventajas que hemos visto para los gráficos.  No obstante, veremos cómo, en algunas ocasiones, interesará convertir los clips de película en gráficos para que aquellos se comporten de otra manera.


La creación de uno u otro tipo de símbolo se puede realizar a través de la opción de menú Insert/New symbol (Insertar/Nuevo símbolo).  Esto dará paso a una ventana en la que se podrá elegir el tipo de símbolo y asignarle un nombre.  Posteriormente, será posible cambiar el comportamiento de cada símbolo, es decir, un tipo de símbolo podrá ser convertido en otro.

Gráfico


Un gráfico es un objeto cualquiera que puede haber sido dibujado directamente con las herramientas del programa, o bien importado desde otra aplicación y convertido a formato vectorial.  En principio, los objetos carecen de cualquier tipo de animación pero son la base desde la que se parte para crearlas, es decir, si desea, por ejemplo, crear la animación de un círculo que se mueve, primero deberá crear el objeto gráfico “círculo” y a partir de ahí, aplicarle las operaciones necesarias para que se mueva.

Botón


Un botón es un elemento al que se le han añadido una serie de propiedades que le permite actuar como un botón, es decir, un gráfico al que se le podrán añadir acciones para que al pasar el cursor por encima o hacer clic sobre él, suceda algo.

Clip de Película


Un clip de película es un símbolo de animación en los que un objeto va cambiando de posición, tamaño, forma, color, etc.

Otros Elementos en Flash


Además de los objetos que hemos visto, también podremos utilizar imágenes bitmaps y sonidos.  La conjugación de gráficos, botones, clips de sonidos e imágenes debidamente organizados, nos permitirá crear películas de Flash para ser utilizadas en la Web o en otro sitio.

El Lanzador


La parte inferior de la ventana del escenario muestra el lanzador, que consiste en una serie de pequeños iconos que le permitirán acceder a algunas de las funciones más comunes de Flash.


Concretamente podrá acceder a los paneles Info ( ), Mixer o Mezclador ( ), Character o Carácter ( ), Instance o Instancia ( ), Movie explorer o Explorador de películas ( ), Actions o Acciones ( ) y Library o Biblioteca ( ).

Las Capas


La zona izquierda de la ventana de la línea de tiempo está destinada al control de las capas en Flash.  Por defecto aparece una capa creada, pero es posible añadir las que desee.  El ubicar cada elemento en una capa diferente nos permitirá tener un mayor control sobre el desarrollo de la película y evitará posibles complicaciones a la hora de reproducirla.


Por otra parte, Flash permite añadir un tipo especial de capa denominado “capa de máscara” que podrá servir, entre otras cosas, para ocultar o mostrar elementos de la escena.  Finalmente, otro tipo especial de capa denominada “capa de guía”, nos permitirá definir una serie de trayectorias invisibles que servirán para hacer que los objetos se muevan siguiendo la forma y dirección de esos trazos.

Las Barras de Herramientas


En los próximos párrafos habremos de discutir las diferentes barras de herramientas que dispone Flash.

Panel de Herramientas Principal


El panel de herramientas principal es aquel que aparece por defecto a la izquierda de la pantalla.  Si lo arrastra desde su barra de título se convertirá en flotante y podrá llevarlo a donde desee.  En cualquier caso, cuando se lleve hasta el lateral izquierdo o derecho de la pantalla, dejará de ser flotante y se adosará automáticamente a ese lado.  Si no está visible puede activar este panel con la orden Windows/Tools (Ventana/Herramientas).


En este panel se encuentran las herramientas principales para el dibujo en Flash.  La parte superior contiene las herramientas de dibujo y selección propiamente dichas, la parte central muestra las herramientas de visualización junto con los selectores de color y la parte inferior está dedicada a las opciones o modificadores de cada herramienta (si los tiene).  Dependiendo de la herramienta elegida se mostrarán unas u otras opciones.


A continuación se relacionan las diferentes herramientas junto con su icono y una breve descripción del cometido de cada una de ellas.

· Arrow o Flecha ( ):  Permite seleccionar objetos o partes de objetos haciendo clic sobre ellos o encuadrando la zona a seleccionar en un marco.

· Subselect o subseleccionar ( ):  Permite seleccionar un objeto para su edición por puntos de control.

· Line o Línea ( ):  Permite trazar líneas.

· Lasso o Lazo ( ):  Permite seleccionar áreas irregulares de los objetos.

· Pen o Pluma ( ):  Permite dibujar curvas y rectas del tipo Bézier.

· Text o Texto ( ):  Permite escribir texto y crear campos de entrada de texto.

· Oval u Óvalo ( ):  Permite dibujar círculos y elipses.

· Rectangle o Rectángulo ( ):  Permite dibujar cuadrados y rectángulos.

· Pencil o Lápiz ( ):  Permite dibujar trazos a mano alzada.

· Brush o Pincel ( ):  Permite dibujar trazos similares a los de un pincel.

· Ink o Bote de tinta ( ):  Permite trazar líneas y formas con colores sólidos, pero no con degradados ni mapas de bits.

· Paint bucket o Cubo de pintura ( ):  Permite rellenar con color áreas cerradas coloreando áreas vacías o bien cambiando de color la pintura actual.  Puede utilizar colores sólidos, rellenos degradados o de mapa de bits.

· Droper o Cuentagotas ( ):  Permite copiar los atributos de trazo y relleno de una forma o línea y aplicarlos de forma inmediata a otra.  Esta herramienta también permite copiar la imagen de un mapa de bits para utilizarla como pintura.

· Eraser o Borrador ( ):  Permite eliminar líneas y pintura.  Puede borrar todo el escenario con rapidez, borrar segmento de líneas y rellenos o borrar por arrastre.

· Hand o Mano ( ):  Permite mover el escenario de forma que su visualización cambie sin necesidad de cambiar el grado de aumento.

· Zoom ( ):  Permite acercar o alejar la imagen.

· Stroke color o Color de trazo ( ):  Permite cambiar el color de las líneas.

· Fill color o Color de relleno ( ):  Permite cambiar el color de los rellenos.

Barra de Herramientas Principal


Puede acceder a ella mediante la orden Windows/Toolbars/Main (Ventana/Barras de herramientas/Principal).  En esta barra aparecen las clásicas herramientas de las aplicaciones de Windows, a saber: New, Copy, Cut, Paste (Nuevo, Copiar, Cortar, Pegar), entre otras específicas de Flash.

Barra de Estado


Se encuentra situada en la parte inferior de la escena.  La barra de estado mostrará información sobre comandos y botones, así como sobre el estado de las teclas Caps Lock (Bloq Maýus) y Nums Lock (Bloq Nim).

Barra de Control


Mediante esta barra podrá controlar cómodamente la reproducción, bobinado, rebobinado y paro de una película de Flash.  El manejo es idéntico al de los botones de un reproductor de casete o de vídeo.  Puede visualizar esta barra mediante la orden Window/Toolbars/Controller (Ventana/Barras de herramientas/Controlador).

Los Paneles y Ventana


Como se ha dicho, la mayoría de estos paneles aparecen inicialmente agrupados en las ventanas de paneles de las que hemos descrito.

Panel Info


Accesible mediante la orden de Windows/Panels/Info (Ventana/Paneles/Info).  Muestra y permite modificar las coordenadas de situación del objeto seleccionado, su altura y su anchura.  Igualmente, muestra los valores RGB y Alfa (transparencia) del color que se encuentre bajo el cursor, así como las coordenadas de éste.

Panel Relleno


Accesible mediante la orden de Windows/Panels/Fill (Ventana/Paneles/Relleno).  Permite rellenar el objeto seleccionado con un color sólido, un degradado o un bitmap.  La posibilidad de aplicar uno u otro tipo de relleno dependerá del tipo de objeto de que se trate.  Además, desde este panel se podrá crear nuevos degradados, editar los existentes y guardarlos para poder utilizarlos posteriormente.

Panel Trazo


Accesible mediante la orden de Windows/Panels/Stroke (Ventana/Paneles/Trazo).  Permite cambiar o asignar el estilo, grosor y color de las líneas.

Panel Transformar


Accesible mediante la orden de Windows/Panels/Transform (Ventana/Paneles/Transformar).  Permite escalar, rotar e inclinar el objeto seleccionado.

Panel Alinear


Accesible mediante la orden de Windows/Panels/Align (Ventana/Paneles/Alinear).  Permite alinear y/o distribuir entre sí varios objetos seleccionados a la vez.

Panel Mezclador


Accesible mediante la orden de Windows/Panels/Mixer (Ventana/Paneles/Mezclador).  Permite seleccionar colores sólidos para aplicar a las líneas o a los rellenos y seleccionar colores y degradados para aplicar a los rellenos.  También permite variar el grado de transparencia (Alfa) y los valores de los componentes RGB y HSB de los colores.

Panel Muestras


Accesible mediante la orden de Windows/Panels/Swatches (Ventana/Paneles/Muestras).  Muestra y permite aplicar los colores y rellenos correspondiente a una película de Flash determinada, es decir, es la paleta asociada a un determinado archivo de Flash.  Los colores y rellenos que hayan sido creados para una película específica, aparecerán en esta paleta únicamente cuando se encuentre en edición esa película.  Mediante esta paleta podrá aplicar, importar, exportar, añadir, quitar y clasificar colores.

Panel Carácter

Accesible mediante la orden de Windows/Panels/Character (Ventana/Paneles/Carácter).  Permite seleccionar los parámetros de texto a aplicar (fuente, estilo, tamaño, etc) y dispone de una casilla en la que se puede definir un enlace (vínculo) para ir desde ese texto a otro lugar.

Panel Párrafo


Accesible mediante la orden de Windows/Panels/Paragraph (Ventana/Paneles/Párrafo).  Permite definir las características del texto de párrafo  (alineación, márgenes y sangrías).

Panel Opciones de Texto


Accesible mediante la orden de Windows/Panels/Text options (Ventana/Paneles/Opciones de texto).  Permite definir si el texto será estático, dinámico o de entrada.
Panel Instancia


Accesible mediante la orden de Windows/Panels/Instance (Ventana/Paneles/Instancia).  Permite cambiar las características de una instancia la cual, como ya hemos visto, es la representación en ;la escena de un símbolo de la biblioteca, es decir un objeto que ha sido arrastrado desde la biblioteca a la escena.

Panel Efecto


Accesible mediante la orden de Windows/Panels/Effect (Ventana/Paneles/Efecto).  Permite asignar efectos de color, brillo y transparencia a un objeto seleccionado.

Panel Parámetros de Clip


Accesible mediante la orden de Windows/Panels/Clip parameters (Ventana/Paneles/Parámetros de clip).  Permite escribir acciones en un clip inteligente que utilicen los parámetros definidos con objeto de cambiar su comportamiento.  

Panel Fotograma


Accesible mediante la orden de Windows/Panels/Frame (Ventana/Paneles/Fotograma).  Permite asignar nombre al fotograma seleccionado, así como asignarle algún tipo de animación y controlar su aceleración, giros, entre  otros.

Panel Sonido


Accesible mediante la orden de Windows/Panels/Sound (Ventana/Paneles/Sonido).  Permite, entre otras cosas, asignar sonidos y efectos de sonido.

Panel Escena


Accesible mediante la orden de Windows/Panels/Scene (Ventana/Paneles/Escena).  Permite acceder o seleccionar una escena determinada.

Ventana Acciones


Accesible mediante la orden de Windows/Actions (Ventana/Acciones).  Permite asignar acciones a los fotogramas, botones y los clips de película.

Ventana Explorador de Películas


Accesible mediante la orden de Windows/Movie explorer (Ventana/Explorador de películas).  Proporciona una manera fácil para poder ver y organizar el contenido de la película y seleccionar elementos para su modificación.

Ventana Biblioteca


Accesible mediante la orden de Windows/Library (Ventana/Biblioteca).  En este lugar es donde se almacenarán y organizarán los símbolos que cree en Flash y también todo aquello que importe de otro lugar como, por ejemplo, bitmaps, sonidos, entre otros.  Las características de este panel le permitirán, entre otras cosas, organizar los elementos por carpetas o categorías, duplicar elementos, cambiar su comportamiento, entre otros.

Ventana Bibliotecas Comunes


Accesible mediante la orden de Windows/Common libraries (Ventana/Bibliotecas comunes).  Desde esta biblioteca podrán acceder a una serie de elementos tales como botones, gráficos, sonidos, entre otros, que ya vienen incorporados en Flash y que están listos para ser utilizados.

Configuración y Agrupación de Paneles


Tal como se dijo al principio, tras el primer arranque de Flash varios de los paneles que acabamos de ver aparecen agrupados en cuatro ventanas.  Haciendo clic en la pestaña correspondiente al nombre de cada panel, se abrirá para acceder a sus opciones.  No obstante, es posible agrupar los paneles como desee.  Para ello, haga estas operaciones:

· Si desea individualizar un panel agrupado, es decir, sacarlo de la ventana para que aparezca de forma independiente, arrastre desde su pestaña a un lugar cualquiera fuera de la ventana.

· Si desea llevar un panel independiente a una ventana para agruparlo con otros paneles, arrastre de la pestaña de cualquiera de los paneles que se encuentre en la ventana en donde desea el nuevo panel.

Tenga en cuenta que aunque en el menú Windows/Panels (Ventana/Paneles) dispone de una opción individual para mostrar cada uno de los paneles, si el que seleccione está agrupado con otros, la ventana que abra los contendrá todos pero, eso sí, el que ha seleccionado desde el menú aparecerá ya abierto.  Si selecciona la opción Windows/Panel sets/Default layout (Ventanas/Conjunto de paneles/Diseño predeterminado), recuperará la configuración inicial de ventanas de grupos de paneles.

Otros Elementos de Pantalla


Además de lo que hemos visto, en la pantalla de Flash aparecen otras herramientas que se describen a continuación:

· Bajo la parte de la línea de tiempo en donde aparecen las capas:

· Insertar capas ( )

· Añadir capas de guía( )

· Borrar capas ( )

· Otros iconos - se encuentra en el vértice superior izquierdo de la línea de tiempo ( ):  Permiten seleccionar una escena para editarla o simplemente para regresar a ella desde una ventana de edición de símbolo.

· Presionando el icono ( ):  Podrá acceder directamente a los símbolos que posea en el panel de biblioteca para editarlos individualmente.

· Iconos ubicados en la zona inferior de la línea de tiempo:  Permitirán trabajar con pieles de cebolla con objeto de visualizar de forma atenuada el contenido de varios fotogramas a la vez.

· El icono ( ):  Permite centrar la cabeza lectora en el centro de la ventana de línea de tiempo  cuando hay una película seleccionada.

Los Menú de Flash


Los menús de Flash le darán acceso a muchas de las operaciones que pueden realizarse desde las paletas, pero también le permitirán realizar otras muchas operaciones que no son accesibles desde las paletas.

Los Menús Contextuales


Una forma ágil de seleccionar comandos en Flash es hacer uso de los menús contextuales que posee.  Un menú contextual es aquel que aparece al hacer clic con el botón derecho del ratón sobre un determinado elemento de la escena.  Dicho menú contendrá, además de comandos comunes, comandos específicos para la edición del elemento sobre el que se hallaba el cursor cuando se ha hecho clic con el botón derecho del ratón, proporcionándose así un método para acceder rápidamente a los comandos y propiedades más útiles relacionados con la ventana o el objeto con el que esté trabajando.

La Ayuda de Flash


Flash dispone de una estupenda ayuda organizada como una página Web.  Desde el menú Help (Ayuda) podrá acceder a varias opciones de ayuda.


Presionando la tecla F1 se abrirá el explorador de Internet y accederá a la ayuda principal del programa, la cual está perfectamente organizada e incluye un tutorial de manejo de Flash

Filosofía de Trabajo en Flash


Para poder trabajar de forma eficiente en Flash, es imprescindible conocer exactamente su filosofía y mecánica de trabajo, puesto que, en caso contrario, resultará muy complicado avanzar en su conocimiento.


Se recomienda definir un símbolo para cada uno de los gráficos y clips que se vayan a utilizar y tenerlos en la biblioteca listo para ser incorporados a la escena las veces necesarias.


De todos modos, cuando se trate de animaciones muy sencillas, podrá crearlas directamente en la escena con la garantía de que no se le van a complicar las cosas.  La práctica con el programa será quien le indicará en cada momento el modo más adecuado para crear películas.

Flash y la Publicación de Páginas Web


Para poder visualizar una película de Flash dentro de una página Web se necesita un archivo con la extensión.swf, que es un archivo que se genera automáticamente cada vez que realiza una previsualización desde Flash presionando, por ejemplo, la tecla [F12]  o [Ctrl.] + [Intro].  Ese archivo es el que habrá que ubicar en nuestra página Web junto con el correspondiente código HTML necesario.

LOS FUNDAMENTOS PARA CREAR ANIMACIONES

La Línea de Tiempo


Los elementos de la línea de tiempo que requeridos para la creación de una animación se describen en la siguiente tabla:

	Tabla 1-1: Características de la Línea de Tiempo

	ELEMENTO
	DESCRIPCIÓN

	Capas
	La manera de organizar los elementos de la animación desde la parte de atrás y delantera del Escenario, de manera que un objeto pueda moverse en frente o detrás de otro o pueda hacer transiciones que son independientes de otros objetos.  Los controles de las capas para la película se observan en el lado izquierdo de la Línea de Tiempo.  Cada capa tiene opciones para ser escondidas o mostrar la capa, trancarla e ilustrar su contenido como esquema (bosquejo).

	Fotograma Actual 
	Muestra la posición actual del Curso de la Línea de Tiempo y el número del fotograma del fotograma que está actualmente visible.

	Frecuencia de los Fotogramas (Frame Rate)
	

	Tiempo Recorrido
	

	Visualizador de los Fotogramas
	

	Fotograma Clave en Blanco
	

	Encabezado de la Línea de Tiempo
	

	Fotograma Clave
	

	Cursor de la Línea de Tiempo
	

	


COMENZANDO A TRABAJAR

Ajuste de las Propiedades de la Película


Cada vez que se arranca el programa, aparece una escena vacía lista para trabajar en ella.  Lo que ubique en esta escena pasará a ser una película de Flash tan pronto la visualice pulsando, por ejemplo, [F12] o [Ctrl.]. + [Intro].


Sin embargo, esa película se almacenará con los parámetros y propiedades con los que aparece por defecto cada nuevo documento que se inicie en Flash.  Así pues, si desea variar las características generales de una película, tales como el tamaño, color de fondo, velocidad de reproducción, entre otras, deberá actuar en la ventana de propiedades de la película a la que puede acceder mediante la orden Modify→Movie (Modificar→Película) o bien, haciendo un doble clic en la indicación de 12fps (12 fotogramas por segundo).  En cualquier caso, se abrirá la ventana de propiedades para la película.

Tamaño de la Película


Para variar las medidas de la escena, seleccione la opción Modify→Movie (Modificar→Película) y en la ventana que se abrirá ajuste las dimensiones en las casillas Width (Anchura) y Heigth (Altura) de la zona Dimensions (Dimensiones)


En la casilla Ruler units (Unidades de regla) puede seleccionar las unidades de medida en las que desea trabajar.

Color de Fondo de la Escena


Para cambiar el color de fondo de una película, seleccione la opción Modify→Movie (Modificar→Película) para abrir la ventana de propiedades de la película.  Haga clic en la casilla de color de la sección Background color (Color de fondo) y elija un color de la lista que aparecerá.


El color de fondo que asigne a una escena será el color de fondo de todas las escenas.  En cualquier caso, si desea colores de fondo diferentes para cada escena, puede cubrir cada escena con un rectángulo relleno del color que desee y conseguirá prácticamente el mismo resultado.

Velocidad de Reproducción de la Película


Para variar la velocidad de reproducción, abra la ventana de propiedades de la película mediante la opción Modify→Movie (Modificar/Película) y ajuste una velocidad en la casilla Frame rate (Velocidad fotogramas).  Puede colocar un valor entre 0.01 y 120 fotogramas por segundo, aunque las velocidades más usuales son entre 12 y 24 fotogramas por segundo (fps).

Unidades de Medida


Para cambiar las unidades de medida, seleccione la opción Modif→/Movie (Modificar→Película) para abrir la ventana de propiedades de la película.  Haga clic en la casilla de la sección Ruler units (Unidades de regla) para desplegar una lista con las unidades más comunes.  Lo que aquí elija repercutirá en todas partes, ya que Flash utilizará esas unidades para todo.

Visualizar el Área de Trabajo


El área de trabajo comprende la zona correspondiente a la escena propiamente dicha y todos sus alrededores, que aparecen en color gris oscuro.  Si la opción View→Work area (Ver→Área de trabajo) está activa, cualquier objeto que esté parcial o totalmente fuera del marco de la escena se verá, mientras que si dicha opción está inactiva, no podrá visualizar nada que no se encuentre dentro de los límites de la escena.  En cualquier caso, cuando se reproduzca la película sólo aparecerá en la pantalla aquello que se encuentre dentro de los límites de la escena.

Dibujar un Gráfico


Vamos a comenzar a hacer varios trabajos en Flash.  Comenzaremos dibujando unos gráficos que luego iremos utilizando en las próximas secciones.

1. Seleccione la herramienta Oval u Óvalo ( ) ubicada en la barra lateral de herramientas y arrástrela hacia la escena para poder dibujar un círculo.  Si mantiene presionada la tecla de [Shift] mientras mientras arrastre el ratón (para crear el círculo), podrá desarrollar un óvalo perfecto.  Ahora, seleccione la herramienta Arrow o Flecha ( ) y luego haga un clic en el borde del círculo para seleccionar su borde (contorno).  Véase que, si arrastra el círculo desde su contorno podrá moverlo (el borde) de forma totalmente independiente.  Seguidamente, presione la tecla [Del] y el borde del círculo desaparecerá.

2. En la zona de Colors (Colores) localizada en la barra lateral de herramientas, aplique un clic sobre el icono Stroke color o Color de trazo ( ) y seleccione un color para las líneas (borde o contorno) de este de círculo.  Luego, aplique un clic sobre el icono de Fill color o Color de relleno ( ) para escoger un color interno de este óvalo perfecto.

3. Ahora crearemos un rectángulo.  Seleccione la barra de herramientas Rectangle o Rectángulo ( ) ubicado en la barra lateral de herramientas y arrástrelo hacia la escena, de manera que se pueda dibujar dicho rectángulo.  Si se mantiene presionada la tecla de [Shift] se podrá dibujar un cuadrado perfecto.

4. Utilizando la herramienta de selección Arrow tool o Flecha ( ) realice un clic dentro del círculo que dibujo en el primer paso de este ejercicio, se manera que lo pueda seleccionar.  A continuación, se podrá observar que el círculo aparecerá cubierto por una trama para indicar que está seleccionado.  En la región de Color o Colores localizada en la barra lateral de herramientas, haga un clic sobre el icono de Fill color o Relleno de colores ( ) para abrir y escoger un color de la lista de colores que se provee.  En estos momentos, e círculo adoptará el relleno seleccionado.

5. Para poder conservar los elementos creados en la escena, guarde la película con las lternativas File→Save as (Archivar→/Guardar como) y asígnele el nombre que desee.  Este procedimiento creará un archivo con la extensión (,fla), el cual podrá recuperar en cualquier momento con el comando File→Open (Archivo→Abrir).

Convertir los Gráficos en Símbolos

Es necesario convertir el gráfico creado previamente en un símbolo para que pasen a formar parte de la biblioteca y podamos reutilizarlos las veces que queramos.  Cada documento de Flash posee su propia biblioteca conteniendo los elementos utilizados en esa película.  Si desea utilizar la biblioteca de una película diferente, deberá importarla mediante el siguiente comando: File→Open as library (Archivo→Abrir como biblioteca).

1. Seleccione el gráfico (el círculo) con la herramienta de Flecha (Arrow tool) y elija la opción Modify→Convert to symbol (Modificar→Convertir en símbolo) o presione la tecla [F8].  En ambos casos, se abrirá una ventana en la que deberá escribir el nombre del símbolo y determinar en qué tipo de símbolo desea convertir el gráfico.  Seleccione comportamiento Graphic (Gráfico) e introduzca el nombre “círculo”.  Observe cómo ahora, al seleccionar el gráfico ya no aparece la trama de antes sino que aparece rodeado por un marco, lo cual indica que ahora se trata ya de un símbolo.  Si presiona le icono del lanzador ( ) en la parte inferior derecha de la ventana de la escena, se abrirá la biblioteca mostrando el símbolo gráfico creado.  Si aplica un clic sobre su nombre, verá cómo la biblioteca muestra un detalle del símbolo en la parte superior.

2. Realice el mismo procedimiento anterior con el cuadrado (rectángulo perfecto).  En este caso asígnele el nombre de “cuadrado” al activar la ventana dedicada a convertir este dibujo a un símbolo en la biblioteca.

3. Nótese que el icono que aparece a la izquierda de cada elemento de la biblioteca indica su tipo de comportamiento.  En este caso, aparece el icono ( ), el cual es el que identifica los símbolos gráficos

4. Guarde una vez más el documento.

Crear una Animación Fotograma a Fotograma


Ahora emplearemos los símbolos para crear una animación sencilla del tipo fotograma a fotograma.  El método de crear animaciones fotograma a fotograma es el más adecuado para realizar animaciones complejas del tipo de las que forman las películas de dibujos animados, en los que cada fotograma muestra un dibujo ligeramente diferente al del anterior.

1. Seleccione la opción Edi→Select all (Edición→Seleccionar todo) para seleccionar a la vez todos los elementos de la escena y presione la tecla [Del] para eliminarlos.  No se preocupe, los tenemos bien guardados en la biblioteca y en el documento que ha guardado antes.

2. Si no está visible, abra la ventana de biblioteca presionando en el lanzador ( ).  Haga clic sobre el símbolo llamado círculo y arrástrelo a un lugar cualquiera de la escena.  Fíjese en la línea de tiempo; aparece el primer fotograma de la película mostrando un círculo negro en su interior.  Esto significa que lo que ahora muestra la pantalla constituye el contenido del primer fotograma de película, la cual, de momento, sólo dispone de ese único fotograma.  Si cambia de posición o aspecto el círculo cambiará también el contenido del primer fotograma, es decir, todo lo que haga o deje de hacer en la escena mientras esté marcado el primer fotograma afectará únicamente a ese fotograma.

3. Vamos a crear un nuevo fotograma para la película.  Para ello haga clic sobre el segundo fotograma para poder seleccionarlo y a continuación presione la tecla [F6].  Este procedimiento provocará la creación de un nuevo fotograma clave, que no es otra cosa que un fotograma en el que se definirá algún cambio en la animación, ya sea de tamaño, posición, color, entre otros.  Este nuevo fotograma clave contendrá, de momento, lo mismo que el fotograma anterior.

4. En esto momentos contamos con una película de dos fotogramas.  Ahora queremos definir lo que debe aparecer en el segundo.  Para esto, seleccione el círculo en la escena y desplácelo hacia la derecha diez veces mediante la tecla de cursor derecha.

5. Haga  clic en el tercer fotograma, de manera que se pueda seleccionar.  Ahora, presione la tecla [F6] para añadir un tercer fotograma clave.  Mueva el círculo otros diez pasos hacia la derecha.

6. Repita el paso anterior varias veces hasta llegar al fotograma 10.  Consecuentemente, se habrá creado una película que consta de 10 fotogramas, donde en cada uno de los fotogramas el círculo se ha desplazado diez pasos hacia la derecha.

7. Como resultado, cada fotograma clave contiene una posición del círculo ligeramente más avanzada que el anterior. 

8. Para poder observar esta animación, presione la tecla [Ctrl.].  Se podrá ver el círculo moviéndose lentamente hacia la derecha.

9. Vamos ahora a cambiar las características del círculo.  Primero, seleccione el segundo fotograma haciendo un clic sobre él.  Ahora, escoja el círculo y desplácelo diez pasos hacia abajo mediante la tecla de cursor correspondiente.

10. Segundo, seleccione el tercer fotograma.  Elija el círculo y desplácelo hacia arriba también diez pasos.

11. Tercero, repita el paso previo en cada uno de los fotogramas restantes.

12. Reproduzca la escena.  Para esto aplique un clic sobre la tecla [F12] o [Intro].

13. Cambie el color de relleno del círculo en algunos fotogramas.  Para ello, haga clic en el fotograma que desee y aparecerá el círculo en la posición que tiene asignada en ese fotograma.  Escoja dicho círculo y cambie el color de relleno mediante la herramienta Fill color o Color de relleno ( ) ubicada en la sección Colour (Color)de la barra lateral de herramientas.  Verá cómo, aunque el color cambia en la herramienta, el círculo permanece con su relleno original.  El motivo está en que ahora el círculo es un símbolo gráfico que se ha arrastrado desde la biblioteca y no un gráfico independiente.  Así pues. Para poder cambiar el color de un símbolo en un fotograma particular, puede llevar a cabo una de las dos alternativas:

a. Con el círculo seleccionado, abra el panel Effect (Efecto), seleccione el efecto Tint (Tinta) y seleccione un color con alguno de los métodos que ofrece el panel.

b. Con el círculo seleccionado active el comando Modify→Break apart (Modificar→Separar), a partir de cuyo momento podrá cambiar su color de relleno mediante la herramienta de relleno mencionada.  Para devolver a su estado el gráfico, seleccione Modify→Group (Modificar→Agrupar).

14. En el caso que lo que desea es cambiar el color de todos los círculos a la vez, se puede editar el símbolo del círculo en una ventana independiente.  Para ello, puede hacer un doble clic sobre el círculo en uno de los fotogramas que contenga todavía el círculo original o bien, hacer un doble clic sobre el nombre del círculo desde la biblioteca.  En cualquier caso, se abrirá una ventana aislada para poder modificar dicho círculo.  Si se fija, en la parte superior de la ventana de línea de tiempo verá cómo aparece una pestaña con el texto Scene 1 (Escena 1), que es donde está creando la película, y otra pestaña con el texto círculo, indicándose así que está en la ventana de edición de ese elemento.  Una vez editado el círculo, puede volver a la escena haciendo clic sobre la pestaña Scene 1 (Escena 1).  Si cambia el aspecto del círculo editándolo independientemente en su ventana, cambiará el aspecto del círculo en todos los fotogramas que lo contengan todavía como símbolo, mientras que aquello fotogramas en los que el círculo haya sido separado, éste permanecerá como estaba.  Cambie, pues, el fondo de los fotogramas que desee.

15. Reproduzca la película para ver el efecto conseguido, que no será otro que el de un círculo que avanza hacia la derecha dando botes y cambiando de color de vez en cuando.

16. Si desea que la animación se reproduzca ininterrumpidamente, seleccione la opción Control→Loop playback (Control→Reproducir sin fin).  Presione la tecla [F12] o [Intro] para iniciarla.

17. Presione el icono ( ) que aparece en el vértice superior de la línea de tiempo, y en el menú que surgirá seleccione Preview in context (Previsualizar en contexto).  Eso provocará que los fotogramas cambien y se muestre el contenido de cada uno en la posición relativa que ocupa en la pantalla, es decir, verá cada uno de los círculos correspondientes a cada fotograma con su color y su posición.

18. Para regresar al modo de visualización normal, seleccione la alternativa Normal en el mismo menú descrito.

Crear una Animación Interpolada


Flash dispone de otro sistema de animación mucho más versátil para cuando se trata de animar objetos menos complicados.  Se trata de la interpolación, cuya filosofía se podría basar en la frase “dime cómo son el primer y último fotograma de película y yo te crearé los fotogramas intermedios automáticamente”.


Flash proporciona dos tipos de interpolación: La interpolación de movimiento, que permite animar objetos previamente agrupados y la interpolación de forma, que permite crear animaciones junto con transformaciones de forma (morphings) entre objetos que no deben estar agrupados.

Crear una Interpolación de Movimiento


En las interpolaciones de movimiento los objetos deben ser símbolos o estar agrupados para que la interpolación se cree correctamente.  Siga los siguientes pasos para crear una interpolación de movimiento:

1. Abra un nuevo documento a través de siguiente comando: File→New (Archivo→Nuevo).  Aplique un clic sobre el icono () ubicado en el lanzador para poder visualizar la biblioteca.  Nótese que dicha biblioteca se encuentra vacía puesto que se acaba de crear un nuevo documento y aún no existen nada en él.

2. Para no tener que dibujar una vez más los elementos creados en los ejercicios previos, vamos a importarlos.  Para poder realizar este procedimiento, escoja la alternativa File→Import→Import to Stage (Archivo→Import→Import to Stage) y elija el nombre del archivo que corresponde a la práctica previa.  A continuación, se podrá observar que se abre la biblioteca correspondiente a dicha película, es decir, ahora se encuentra en la pantalla de su máquina una biblioteca vacía y otra con elementos.  Ahora bien, si arrastra, por ejemplo, el círculo hasta la escena vacía se verá cómo automáticamente la biblioteca vacía mostrará también el círculo.  Además, es posible arrastrar los elementos de una biblioteca a otra biblioteca directamente.

3. Coloque el círculo hacia el lado izquierdo de la escena.  Una vez más, dicha ubicación será la posición del círculo en el primer fotograma.

4. Escoja el primer fotograma haciendo un clic sobre éste.  Luego, presione el botón derecho del ratón para que aparezca el menú contextual.  Escoja el comando Create motion tween (Crear interpolación de movimiento).

5. Elija el fotograma número 20 al aplicar un clic con el ratón sobre él.  Seguidamente, presione la tecla [F6] para crear el último fotograma clave de la película.  De manera instantánea, se podrá observar que todos los fotogramas intermedios quedarán sustituidos por una flecha con el fondo de color rozado.  Esto significa que el programa de Flash ha creado de forma automática todos los fotogramas intermedios partiendo únicamente del primero y del último.

6. El próximo paso será definir la posición final que debe poseer el círculo al llegar al final de la película.  Para esto, estando seleccionado el fotograma 20, arrastre el círculo hasta la derecha de la escena.

7. Presiona la tecla [F12] o [Intro] para ver cómo se desarrolla la animación.  Se podrá observar que cada fotograma intermedio ha sido calculado o alterado automáticamente por el programa

8. Ahora vamos a hacer que el círculo, además de desplazarse, vaya aumentando de tamaño.  Para poder realizar este efecto, primero seleccione el último fotograma (el número 20).  Luego, abra el menú contextual aplicando un clic con el botón derecho del ratón sobre el círculo y seleccione al alternativa Scale (Escalar).

9. Seleccione un de los tiradores (handles) localizados en los vértices del círculo.  Seguidamente, arrastre hacia fuera dicho tirador para poder aumentar el tamaño del círculo.

10. Presione la tecla [F12] o [Intro] para reproducir la película.  Véase que el círculo se irá agrandando a medida que se acerca a la derecha de la escena.

11. Ahora vamos hacer otro cambio a la animación.  Haremos que el círculo siga otro camino hasta llegar al borde derecho de la escena.  Para esto, primeramente realice un clic sobre el fotograma 10 mientras se mantiene presionada la tecla [Ctrl.].  Este procedimiento permitirá que se puede escoger dicho fotograma y aparezca el círculo con el tamaño y posición que le corresponde en ese fotograma.

12. Presione la tecla [F6] para crear un fotograma clave en esa posición.  Esto permitirá alterar lo que ocurre en dicho fotograma (el número 10).  La inserción del fotograma clave quedará patente por la aparición de un pequeño círculo en su interior, de manera que la flecha original quedará dividida en dos.

13. Manteniendo la selección del fotograma 10, desplace el círculo hacia la parte inferior de la escena.

14. Presione la tecla [F12] o [Intro] para reproducir la película.  Nótese que ahora el círculo, además de ir agrandando, se mueve hacia abajo para luego, a partir del fotograma 10, volver a subir hasta alcanzar el final de la película.

15. A continuación, vamos ha llevar a cabo otro cambio a esta animación de Flash.  La modificación consiste en hacer que el círculo vaya cambiando de color mientras se desplaza.  Para ello, primero escoja el fotograma central (número 10) de la película.  Ahora, abra la paleta de efectos siguiendo el comando Windows→Panels→Effects (Ventana→Panels→Effect).

16. En la casilla del panel escoja Tint (Tinta) para que se muestre la gama de colores disponibles.  Seleccione un color diferente al que posee el círculo en el fotograma.

17. De la misma manera, escoja el último fotograma y cambie el color al círculo.

18. Presione la tecla [F12] o [Intro] para reproducir la película.  Ahora verá cómo el círculo además de desplazarse hacia la derecha e ir aumentando de tamaño, va cambiando su color.

19. Ahora, haremos una última modificación a este ejercicio.  Vamos a hacer que el círculo vaya cambiando también su forma.  El primer paso consiste en seleccionar el fotograma número 10.  Seguidamente, haga un clic con el botón derecho del ratón sobre el círculo para mostrar su menú contextual.

20. Escoja la alternativa Scale (Escalar) y arrastre de uno de los tiradores laterales para deformar el círculo.  El propósito es achatarlo horizontalmente.

21. A continuación, escoja el fotograma número 20.  Arrastre uno de sus tiradores laterales del círculo para achatarlo verticalmente.

22. Presione la tecla [F12] o [Intro] para reproducir la película.  Podrá observar durante esta animación cómo además del movimiento, el cambio de color y el cambio de tamaño, el círculo va cambiando también su aspecto (su forma).

Crear una Interpolación de Forma


La diferencia básica entre una interpolación de movimiento y una interpolación de forma radica en que, en el primer caso, se trata siempre del mismo objeto al cual se le hacer ir de un lado a otro mientras se le provocan, por ejemplo, cambios de forma, color y tamaño mientras que, en el segundo caso se trata de la conversión de un objeto en otro mediante una serie de pasos intermedios.  Si se aplican colores o efectos a esos objetos, también se calculará el cambio.  En las interpolaciones de forma los objetos no deben estar agrupados ni ser símbolos o de lo contrario la interpolación no se realizará.


En los siguientes pasos desarrollaremos una película que mostrará la transformación de un círculo en un texto.

1. En un documento nuevo, dibuje un círculo con la herramienta Oval u Óvalo ( ) y sitúelo en el centro de la escena.  Elimine su contorno haciendo clic sobre él con la herramienta de Flecha ( ) y presionando la techa [Del].

2. Escoja el fotograma número 40 y presione la tecla [F6] para crear un fotograma clave.  Eso repetirá el círculo en éste y todos los fotogramas anteriores.

3. En el fotograma 40, elija el círculo y bórrelo presionado la tecla [Del].

4. Ahora active la herramienta de Text o Texto ( ) ubicada en la barra lateral de herramientas.  Seguidamente, realice un clic sobre la escena para que aparezca el cursor de texto y escriba la palabra “círculo”.

5. Haga un doble clic sobre el texto recién escrito para seleccionarlo.

6. Si no está a la vista, abra el panel de caracteres de texto presionando la herramienta de Texto ( ) en el lanzador.  Ajuste un tamaño, estilo y tipo de letra adecuados procurando que la altura del texto sea similar a la del círculo.

7. Mediante la herramienta de selección ( ) arrastre para situar el texto en el centro de la escena.

8. Con el texto seleccionado, elija la alternativa Modify→Break apart (Modificar→Separar) para separar el texto y convertirlo en un gráfico (para hacer animaciones de forma, los objetos no deben estar agrupado, y el texto lo está siempre por defecto).

9. Seleccione el primer fotograma haciendo clic sobre él y aparecerá de nuevo el círculo.

10. Visualice el panel de fotogramas presionando las teclas [Ctrl.] + [F] y en la casilla Tweening (Interpolación), seleccione Shape (Forma).  Automáticamente, los fotogramas del 1 al 40 aparecerán coloreados de verde claro y con una flecha en el sentido de avance de la película.

11. Presione la tecla [F12] o [Intro] para reproducir la película.  Observe cómo el círculo se va transformando en el texto.

Crear Símbolos


Una animación también se almacena en la biblioteca si la convertimos en símbolo, con lo cual podremos disponer de ella las veces que deseemos.  Además, un elemento de la biblioteca es fácilmente duplicable y podremos utilizar la estructura de una animación para crear otras animaciones iguales pero cuyos objetos inicial y final serán diferentes y ahorramos así todo el proceso de creación.

Símbolo Gráfico


Un símbolo gráfico puede ser un gráfico estático, pero también puede ser una animación cuyo desarrollo dependerá de la línea de tiempo principal, es decir, un símbolo gráfico animado que dure 20 fotogramas sólo se reproducirá entero si la película principal consta, al menos de 20 fotogramas.  Puede crear un símbolo gráfico antes (símbolo en blanco) o después de dibujarlo.


Para crear un símbolo partiendo de un gráfico de la escena siga estos pasos:

1. Dibuje un objeto en la escena.

2. Escójalo con la herramienta de selección ( ).

3. Elija Modify→Convert to Symbol (Modificar→Convertir en símbolo) o presione la tecla [F8].  A continuación, se abrirá una ventana en la que deberá introducir un nombre para el símbolo y asignar el tipo de símbolo de que se trata.  En este caso, seleccione Graphic (Gráfico) y acepte.

4. Si ahora visualiza la biblioteca presionando ( ) en el lanzador, verá cómo aparece el nuevo símbolo gráfico con su nombre al lado del icono ( ) representativo de un símbolo gráfico.

Para crear un símbolo gráfico directamente siga los posos de abajo:

1. Seleccione la alternativa Insert→New symbol (Insertar→Nuevo símbolo) y se abrirá la misma ventana que antes.

2. Introduzca un nombre para el símbolo y marque la casilla Graphic (Gráfico) para crear un símbolo gráfico.  Al igual que en el caso anterior, la biblioteca mostrará el nuevo símbolo creado.

Símbolo de Clip de Película


Un símbolo de clip de película es un símbolo similar al del tipo gráfico pero cuya línea de tiempo es independiente y no depende de la línea de tiempo principal, es decir, un símbolo de clip que dure 20 fotogramas se reproducirá hasta el final aunque la película principal sólo tenga un fotograma.


Es indiferente que cree un clip de animación de movimiento o de forma.  El método es el mismo y los símbolos de clip que cree de este modo estarán disponibles en la biblioteca listos para ser arrastrados a la escena principal en cualquier momento.


Para crear un clip de película siga estos pasos:

1. Seleccione la opción Insert→New symbol (Insertar→Nuevo símbolo).  En la ventana que se abrirá asigne un nombre para el clip y active la alternativa Movie clip (Clip de película).

2. Acepte y la ventana de escena se convertirá en un documento en blanco para que cree el clip.  Eso quedará patente porque la parte superior de la ventana de la línea de tiempo muestra ahora dos pestañas, una con el nombre de la escena principal y otra con el nombre del clip en edición.

3. Ahora puede crear la película de forma independiente sin afectar a la escena principal.  Cuando haya terminado el clip de película aparecerá en la biblioteca junto con el icono identificativo de los clips ( ).

Símbolo de Botón


Flash permite la creación de otro tipo de símbolo muy útil, se trata de los botones.  Un botón es un símbolo con su propia línea de tiempo.  Vamos a ver cómo se crea un botón.

1. Seleccione la alternativa Insert→New/symbol (Insertar→New symbol).  En la ventana que se abrirá asigne un nombre para el botón y active la alternativa de menú Button (Botón).

2. Acepte y la ventana de la escena se convertirá en la ventana de edición del botón.  Como siempre, la parte superior de la ventana de línea de tiempo mostrará una pestaña con el nombre de la escena principal y otra con el nombre del botón que se está editando ahora.

3. Observe cómo aparecen únicamente cuatro fotogramas.  Pues bien, los tres primeros se corresponden respectivamente con los tres estados posibles del botón, es decir, en reposo, con el ratón encima y pulsado.  El último fotograma permite definir el área activa del botón.

4. Así, pues, para definir un botón lo que hay que hacer es definir el aspecto que debe tener en cada uno de los casos citados.  Esta operación resulta similar a la que vimos anteriormente cuando creamos una película fotograma a fotograma.  Entre, pues, en la ventana de edición de botones y dibuje un círculo con el tamaño, aspecto y color que desee para la posición de reposo del botón.  Sitúelo centrado con la pequeña cruz que aparece en el centro de la pantalla.

5. Bien, ya tenemos definido el aspecto del botón en el primer fotograma.  Ahora, escoja el segundo fotograma haciendo clic sobre él y presione la tecla [F6] para crear un nuevo fotograma clave.  El círculo del fotograma anterior se repetirá en este fotograma.

6. Ahora puede sustituir el dibujo del círculo por otra cosa o, simplemente, cambiarle el color.  En cualquier caso, haga lo que haga, lo que aparezca en la pantalla mientras está seleccionado el segundo fotograma es lo que aparecerá cuando al reproducir la película pase el cursor del ratón por encima del botón.

7. Seleccione el tercer fotograma y presione la tecla [F6] para crear un fotograma clave en esa posición.  Aquí estamos en lo mismo, es decir, debe modificar el círculo para que adopte el aspecto que desea que aparezca cuando haga clic sobre él.  Puede modificarlo, cambiarlo por otra cosa, entre otros.

8. Con la definición de los tres primeros fotogramas el botón ya funcionará.  El cuarto fotograma está destinado a definir el área útil del botón, ya que puede interesarnos que sólo una parte de la imagen del botón resulte activa.  Por ahora, habrá que asignarle al botón la acción que queremos que produzca cuando se haga clic sobre él.  Eso se definirá una vez colocado el botón en la escena principal, seleccionándolo y mediante la ventana de acciones de fotograma a la que se le puede acceder mediante la orden Windows→Actions (Ventana→Acciones).

9. Así, pues, una vez creado el botón pulse en la pestaña Scene 1 (Escena 1) para volver a la escena.

10. Ahora arrastre el botón desde la biblioteca hasta la escena principal.  Los símbolos de botón aparecen en la biblioteca precedidos por el icono ( ).

11. Si ahora selecciona Control→Test movie (Control→Probar película) pondrá la escena en marcha.  Observe cómo, si pasa el cursor del ratón por encima del botón éste adopta el aspecto que le haya asignado.  Igualmente, si hace clic sobre él aparecerá lo que haya dibujado en el tercer fotograma de la ventana de edición de botones.

Otros Símbolos


Además de los símbolos que hemos visto, Flash trabaja con otros elementos que no pueden crearse desde Flash y que son, en consecuencia, importados, pero que también quedarán almacenados en la biblioteca y también serán denominados símbolos por su comportamiento y características.  Básicamente esos otros símbolos son los sonidos y las imágenes bitmap.

Capas


El trabajo con capas le permitirá estructurar mucho mejor la escena y evitará problemas de interacciones entre sus distintos elementos.  Efectivamente, cuando se trate de escenas con cierto grado de complejidad o en las que intervengan muchos elementos, resultará ventajoso ubicar cada uno de esos elementos en una capa independiente.


Inicialmente Flash muestra una película en blanco con una sola capa, pero puede crear las que desee presionando el icono ( ) bajo la ventana de capas.  Si hace doble clic sobre el nombre de una capa podrá asignarle el nombre que desee.


Los puntos negros que aparecen en la columna encabezada por el ojo ( ) permiten ocultar o mostrar la capa haciendo clic alternativamente sobre ellos.

GLOSARIO

Activo (Asset):  Término general para un objeto almacenado en la biblioteca de Flash.  Representan elementos reusables que se pueden importar a la película.
Componente:  Tipos especiales de segmentos de películas que poseen una apariencia predefinida y funcionalidad.  Representa un “segmento de película inteligente” que esta más integrado en el ambiente de creación de Flash.

Proyectores:  Un archivo que corre independiente (autónomo), que posee un icono especial.  Representan aplicaciones auto-suficientes para reproducir un contenio de Flash.  Es una manera práctica para distribuir las películas.
Símbolos:  Son gráficas creadas con las herramientas de dibujo de Flash y almacenadas en una biblioteca.  Objetos que guardamos en la biblioteca para volver a usarlo cuantas veces necesitamos en la película.  Un objeto o conjunto de objetos que se les da nombre y se guardan en la biblioteca.
Escenario (Stage):  El rectángulo localizado en el medio de la pantalla de Flash, donde se colocan los objetos.

Instancia:  Es un símbolo que se inserta en el escenario.  Representa una copia de un símbolo que se puede utilizar en el escenario y para la creación de la animación.  Cada vez que arrastramos un símbolo de la biblioteca al escenario, estamos utilizando una instancia del mismo.  Es posible alterar ciertas propiedades de las instancias sin afectar al símbolo.
Fotograma:  Una representación de una cantidad pequeña de tiempo en la línea de tiempo que posee una animación.  De manera predeterminada (default), representa ½ segundo.  Un conjunto de fotogramas exhibidos uno después del otro crean la animación. Su analogía es una página.  En las primeras animaciones, se conocían como “cels” (hojas o páginas transparentes)
Fotogramas claves:  Representan aquellos fotogramas más cruciales que definen un movimiento.  Son cualquier cambio significativo en la animación, lo cual puede incluir la alteración de un carácter o gráfica.  Fotogramas en la línea de tiempo que contienen imágenes o un nuevo contenido.
Fotograma en blanco:  Un fotograma clave donde en escenario no posee objetos.

Run-time:  Periodo o tiempo de ejecución.  Archivos que corren sin la necesidad de la aplicación.

Fotograma entre medio (In-between frames):  Fotogramas regulares (no claves).  Cambios incrementales para simular el movimiento.

Ambiente de Autoría:  Herramientas que dispone Flash para crear y editar los proyectos.

Película (Movie):  Un archivo de Flash creado en el ambiente de autoría.
Segmento de película (Movie clip):  Una animación incluida en un símbolo.
Clases:  Son los planos o proyectos que definen un grupo de objetos.
Línea de tiempo (Timeline):  Un conjunto de fotogramas de una película a través de la cual se reproduce la animación.

Biblioteca:  El almacén para los símbolos, imágenes bitmaps importadas y sonidos.

Capa (layer):  Un nivel sobre el escenario que contiene objetos.

Movimiento interpolado (motion tween):  Una animación que mueve objetos, creada al definir los puntos de inicio y final y dejando que Flash automáticamente llene el movimiento entre medio.

Objetos:  Son instancias de las clases.

Métodos:  Representan los comportamientos de un objeto.  Un método es el comportamiento integrado en el objeto que posee un código de ActionScript.
Alternar (Toggle):  Pasar de un modo o estado a otro.
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